Publish Your iOS App - Tactile Media 8/30/13

This lesson explains how to:

- Set up your iDevice for testing

- Navigate Apple's iOS development portal

- Add your iDevice to your account

-Create anapp ID

- Create a development provisioning file

- Transfer your app to your iDevice for testing

Note that the combination of LiveCode and Xcode can cause the standalone building process to
fail. At the time of writing this document, my working setup is:

- LiveCode 5.5.5

- Xcode 4.6.2

-0OS X10.7.5

STEP 1 - Get The UDID Number Of Your Test Device
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Begin by obtaining the UDID number of your test device. The easiest way to retrieve the ID is to
geta free app in Apple's app store called UDID Sender. Launch the app on your iDevice and
choose the "Send UDID via E-Mail" option. Make sure to have the resulting email handy for use
on Apple's site.
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Launch Apple's Developer Site

@ Apple Developer

A

2 & Apple Inc. [US] https://developer.apple.com

’
[ ¢ Developer Technologies Resources Programs Support

Design. Code. Build. Innovate.
Here's where it all happens for Apple developers.

Go to developer.apple.com.

Find the iOS Dev Center Link

.
@ Developer

Technologies

Developer Tools Apple Applications

i0s Forums

0S X Safari Dev Center Videos

Safari App Store Resource Center Licensing and Trademarks
iAd Hardware and Drivers
iCloud iPod, iPhone, and iPad Cases

Open Source

While the main link may appear in different locations on the page, there should always be a text
link in the page footer. Currently, the URL is:

http://developer.apple.com/devcenter/ios/index.action Click this link.
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Sign In on the iOS Dev Center Page

’,
e Developer Technologies ~ Resources Programs Support  Member Center Q search Developer

iOS Dev Center 0S Dev Center

Hi, Guest Register Log In

Access additional resources in the iOS Dev Center.

N

You should see at least two options that can be clicked to sign in here. Click one to begin.

Sign in with the Apple ID you used to register as an Apple Developer, or register for free today.

Enter Your Apple ID and Password

’
® Develoner

Sign in with your Apple ID

Use the Apple ID you used to register or register now.

Apple ID: | scott@tactilemedia.com

Password: | |

Forgot ID or Password?

If you've ever purchased anything from Apple or set up an iTunes account, the same ID and
password usually goes here. Click Sign In.
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Choose Certificates, Identifiers & Profiles

OS Dev Center

Hi, Scott Rossi My Profile Sign out

iOS Developer Program

Certificates, Identifiers & Profiles ©

iTunes Connect ©
Apple Developer Forums ©
Developer Support Center ©

Lc.j App Store Resource Center
ers

h Dranara far Ann Sithmiccinn

After signing in, click this link.
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STEP 2 - Add Your Device To Your Account

[ Developer Technologies

Certificates, Identifiers & Profiles

ii iOS Apps

@ Certificates Jo

_ Ge

@ Identifiers si

i

Learn More
[ App Distribution Guide

Click the Devices option to begin.
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Add A New Device

& Profiles Scott Rossi ¥

iOS Devices + | = Q

[ You can register 78 additional devices.

Name UDID

Sams iPod
Adams iPod
Anil's iPad

Al 4 te_

Click the + button to add a new device. You can register up to 100 devices on your account.

Enter A Name And The UDID For Your Test Device

() Register Device
Name your device and enter its Unique Device Identifier (UDID).

Name: | gilI's iPhone

UDID: | 123456a012abcde1234c0d0agf01efc8d123a0al

Give your device a memorable name and paste the UDID string from the email you generated in
step 1. Click the Continue button at the bottom of the page. Follow any subsequent prompts.
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STEP 3 - Create An App ID

Certificates, Identifiers & Profiles

i0S Apps v
V' Certificates V] 19 App IDs Total
All Name
Pending argzdev
Development BuildASong
Production
guiltyassin
10| Identifiers (V]
LCnetviewer
App IDs
Pass Type | LCnetviewer550
Website Push IDs LCnetviewer553
[J Devices © musitronic
All
onyxiademo
| 1 Provisioning Profiles (V]
orpheumdemo
All
Development plexxr
Distribution plexxr2dev

Pl FYYRuviawar

Click App IDs under Identifiers on the left side of the Certificates, Identifiers & Profiles page.
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Register A New App ID

Scott Rossi ¥

iOS App IDs + | Q

~ 1D

com.tactilemedia.argzdev
com.tactilemedia.buildasong

com.tactilemedia.guiltyassin

ram tartilamaria natviawar

Click the + button toward the top right of the page.

Create An App Description

App ID Description

Name: | MyDummyApp
You cannot use special characters such as @, &, *, ', "

App ID Prefix You shouldn't need to change this

Value: | (Team ID) |

A IN Cuffiv

Enter a simple description for your app. This is NOT the filename that will appear on the iOS
desktop -- itis just a way to identify your app.
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Add An Explicit App ID

(® Explicit App ID
If you plan to incorporate app services such as Game Center, In-App Purchase, Data
Protection, and iCloud, or want a provisioning profile unique to a single app, you must
register an explicit App ID for your app.

To create an explicit App ID, enter a unique string in the Bundle ID field. This string
should match the Bundle ID of your app.

Bundle ID: com.tactilemedia.dummy

We recommend using a reverse-domain name style string (i.e.,
com.domainname.appname). It cannot contain an asterisk (*).

Choose this option unless you're creating a set of apps. Using a domain is good here but not
necessary. Note the recommended form: com.tactilemedia.dummy. Choose any additional
service options on the page and click Continue.

Confirm Your Settings

To complete the registration of this App ID, make sure your App ID information is correct, and
click the submit button.

App ID Description: MyDummyApp

Identifier: % " L8 .com.tactilemedia.dummy

Data Protection: © Disabled

Game Center: @ Enabled

iCloud: © Disabled

In-App Purchase: ® Enabled

Inter-App Audio: © Disabled

Passbook: © Disabled

Push Notifications: © Disabled

If everything looks OK, click Submit. After a few seconds, the page should refresh with a notice
that reads "This App ID is now registered to your account and can be used in your provisioning
profiles." Click Done.
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STEP 4 - Create A Provisioning File

Certificates, Identifiers & Prc

i0S Apps v
¥: Certificates (V]
All
Pending

Development
Production

10 Identifiers V)
App IDs
Pass Type IDs
Website Push IDs

[] Devices )
All

|y Provisioning Profiles V)
All
Developmen

Distribution

Click the Provisioning Profiles link on the left side of the page.
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Add A New Provisioning File

Scott Rossi ¥

iOS Provisioning Profiles /+ =l
~  Type Status
Development @ Active
Development O Expired

Click the + button toward the top right of the page.

Select The “Development” File Type

Add iOS Provisioning Profile

Select Type Configure Generate Download

%
ﬁ What type of provisioning profile do you need?

PROV

evelopment

(*) i0S App Development
Create a provisioning profile to install development apps on test devices.

SelectiOS App Development and click Continue at the bottom of the page.
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Select Your App ID

Add iOS Provisioning Profile

Select Type Configure Generate Download

Select App ID.

If you plan to use services such as Game Center, In-App Purchase, and Push Notifications,
or want a Bundle ID unique to a single app, use an explicit App ID. If you want to create one
provisioning profile for multiple apps or don't need a specific Bundle ID, select a wildcard
App ID. Wildcard App IDs use an asterisk (*) as the last digit in the Bundle ID field. Please
note that iOS App IDs and Mac App IDs cannot be used interchangeably.

# App ID: | MyDummyApp (  .com.tactilemedia.dummy)

O
—

You should be presented with a pulldown list of available app IDs. If necessary, change the
selection to the app ID you created earlier in this lesson. Choose Continue at the bottom of the
page.
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Select Your Certificate

Add iOS Provisioning Profile

Select Type ' Configure Generate / Download

@ Select certificates.

PROV

Select the certificates you wish to include in this provisioning profile. To use this profile to
install an app, the certificate the app was signed with must be included.

™ Select All 1 of 1 item(s)

™ Scott Rossi (i0S Development)

Enable the checkbox and click Continue at the bottom of the page.
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Select Your Device

Add i0OS Provisioning Profile

Select Type Configure Generate Download

Select devices.

Select the devices you wish to include in this provisioning profile. To install an app signed w
this profile on a device, the device must be included.

() Select All 0 of 22 item(s)

(] Adams iPod

Andre Gs iPad

O

Anil's iPad

Bill's iPhone h

Chris Ss iPad

& O

O

This device will be included in the provisioning file and will tell iOS that your device is "authorized"
to run your app. Make your selection and click Continue at the bottom of the page.
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Name Your Profile

Add iOS Provisioning Profile

Select Type Configure ‘ Generate Download

@ Name this profile and generate.
PROV

The name you provide will be used to identify the profile in the portal. You cannot use speci
characters such as @, &, *, ', " for your profile name.

Profile Name: | DummyDevProfilel h

Type: Development

App ID: MyDummyApp ("~ = = & .com.tactilemedia.dummy)
Certificates: 1 Included

Devices: 1 Included

Enter a filename for your provisioning file here. | always include "dev" in the name to identify the
profile as a development type profile, but this is not necessary. Click Generate at the bottom of the
page when you're done. After several seconds, you should see a notice stating your provisioning
file is ready.
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Download Your New Provisioning File

Add i0S Provisioning Profile

Select Type Configure Generate Download

Your provisioning profile is ready.

Download and Install
Download and double click the following file to install your Provisioning Profile.

Name: DummyDevProfile
Type: Development
App ID: .com.tactilemedia.dummy

PROV Expires: Aug 30, 2014

Click Download to save the provisioning file to your machine.

Install Your Provisioning File

(&] Downloads

[ - Bolenenirn Q

ISERS | Date Modified
¥ DummyDevProfile.mobileprovision Today 12:11 AM
ot =—t—t—Tc—4=htacdg Yesterday 3:25 PM

» [ cleanStickyFooter Aug 28, 2013 9:40 PM

Double-click the provisioning file in the Finder to launch Xcode. Doing so will make the file
available to LiveCode and your iDevice.

Publish Your iOS App - Tactile Media 8/30/13 - 16



Confirm Device Authorization

"IN

Organizer - Devices

B rE B

Repositories Projects Archives Documentation

LIBRARY (Q~ Prof

: -Name—A-l Platform Creation | Expiration App ldentifier Team Statu:
2§ Software Images BASdev iOS Profile  7/2/12  7/2/13 Tactile Media O Profil
.| Device Logs DummyDevProfile iOS Profile  8/30/13 8/30/14 Tactile Media v Valid
B screenshots PLEXXR iOS Profile  10/7/10 3/6/11 Tactile Media O Profil
TEAMS PLEXXR2dev iOS Profile  7/2/12  7/2/13 Tactile Media O Profil
22 Tactile Media PLEXXRviewerProfile  iOS Profile  6/14/13 6/14/14 Tactile Media © Valid
DEVICES PlexxrDevProfile iOS Profile 7/2/12 7/2/13 Tactile Media O Profil
—— roy7n|5a(g;1 — Secretly iOS Profile  12/13/12 11/18/13 Tactile Media @ Valid
ik SecretlyDevProfile iOS Profile 6/14/13 6/14/14 - Tactile Media ® Valid
— YiyNayAdHoc iOS Profile  12/11/10 3/6/11 - Tactile Media O Profil
';'i'.ls (';;'2‘:,'3 © | vhyNayDevProfile ioS Profile  7/2/12  7/2/13 - Tactile Media O Profil
il S ——— gzdevProfile iOS Profile  8/10/13 8/10/14 Tactile Media @ Vvalid
A Aptions iOS Team Provisioni... iOS Profile 6/14/13 6/14/14 Tactile Media @ Valid
B Console netviewer550DevProfile iOS Profile  7/2/12 7/2/13 Tactile Media O Profil
|| Device Logs netviewer553DevProfile iOS Profile 11/18/12 11/18/13 Tactile Media £ Valid
E Screenshots onyxiaDevProfile iOS Profile 6/14/13 6/14/14 Tactile Media @ Valid
v m gcl"g’gl;';‘)’d orpheumDevProfile  iOS Profile  8/26/13 8/26/14 Tactile Media © Valid

1£] Device Logs

With Xcode running, connect your iDevice to your system with an iPhone cable. Display Xcode's
Organizer window (Window > Organizer). If everything worked correctly, you should see a green
indicator in the Organizer window next to your connected device.

STEP 5 - Build Your iOS Standalone

00 0 Standalone Application Settings for dummy - iOS
= = . Doy é . ™
[¥'s) B "4 ) . i ohrs
General Stacks Copy Files Mac Windows Linux Web i0OS Android Bug Reports
Build for: [QI i0S | iPod and iPhone 3| 4.1orlater + || Universal 3 |
Basic Application Settings Custom URL Scheme
Display Name ' Hummy I Version | 1.0.0 | URL Name |
[ |
Internal App ID | com.yourcompany.yourapp Requirements and Restrictions
Profile | DummyDevProfile )

[ | Persistent WiFi [ | File Sharing [ | Push Notifications

Externals T =
[ ] MySQL [ | PDF Printing
Icons [ ] Prerendered Icon Telephony () o

: D @
Tam Peer-Peer () O @

Required Prohibited n/a

iPhnna [

In LiveCode, choose "File > Standalone Application Settings..." and select the iOS option. There
are many settings here, but the most important is the Profile setting. In the pulldown menu, you
should be able to select the provisioning profile you created and downloaded. Choose any other
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appropriate settings, save your stack, and then choose "File > Save as Standalone Application..."
LiveCode should inform you that your standalone was saved successfully.

STEP 6 - Transfer Your App To Your Device

LAV o B T SR N e e T AN o R D DA e e s s el s A s AN e

LIBRARY
Provisioning Profiles
2@ Software Images

|| Device Logs

B screenshots

TEAMS
22 Tactile Media

DEVICES

My Mac
¥ =910.7.5 (11G63b)
Provisioning Profiles

Bill’s iPhone
vl (9B206) ©

Provisioning Profiles

¥ Applications h

B8 Console

|| Device Logs

Bl Screenshots

= Scott's iPod

v 5 os176)

| | Device Logs

Screenshots [

Data files in Sandbox
TravelPad2
v . (1] Documents
6.1.3 (1.08329) ¥ () Library
| | Device Logs ¥ (L] Caches
Screenshots (0] Snapshots
- ﬂ Scott's iPhone ¥ [[] com.tactilemedia.secretly
5.0 (9A334) % Cache.db
| Device Logs (] com.apple.opengl
Screenshots ¥ (] Preferences
" .GlobalPreferences.plist

Add Delete Download Upload

In the Xcode Organizer window, click the Applications option under your device entry under
Devices.
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Drag Your App To Xcode's Organizer

S ety v oy en e |

LIBRARY

Provisioning Profiles
2 @ Software Images

|| Device Logs dummy 1.0.0

B screenshots

com.yourcompany.yourapp

TEAMS
22 Tactile Media

DEVICES

My Mac
¥ 5510.7.5 (11G63b)
Provisioning Profiles
Bill's iPhone
v B 511 ss208) ©
Provisioning Profiles
B8 Console
|| Device Logs
Bl screenshots

= Scott's iPod
v W5 o8176)
|| Device Logs

E Screenshots Data files in Sandbox

TravelPad2 Documents
villcis (10B329) —

' ¥ [ Library
| | Device Logs {11 Caches
Screenshots ¥ (0] Preferences
@ Scott's iPhone 1 .GlobalPreferences.plist

v
5.0 (3A334) | com.apple.PeoplePicker.plist

| Device Logs L tmp
Screenshots

O v S

Add Delete Download Upload

Locate your standalone app in the Finder and drag itinto the Organizer window. If all works
correctly, a generic icon for your app should now appear in the Organizer window. And this icon
should also appear on your iDevice, allowing you to run it. Success!

From now on, each time you create a new build of your app, you can drop the standalone on the
Applications pane of the Xcode Organizer to replace your app on your iDevice. If you want to be
certain of getting the most recent build onto your iDevice, select your app in the Organizer and
press the Delete button at the bottom of the window before copying over your new build.
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